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About the .NET Conversion Manual

Document Version 3
6/1/2024
Updated for FmPro Migrator Platinum Edition 11.15.
Includes changes throughout the C# converted code to improve compatibility with Visual Studio 
2022. Includes updated Visual Studio screenshots.
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Step 1 - Import Database Info 
- FileMaker Pro
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Licensing FmPro Migrator

As of FmPro Migrator v11, all FmPro Migrator downloads are fully functional with features 
unlocked via a single license key.
This section of the manual shows how to enter the license key to unlock the features within 
FmPro Migrator.

FmPro Migrator 11.15
5/31/2024

Demo Edition Dialog

When launched the first time, FmPro Migrator will be running in Demo mode as shown in this 
screenshot. Clicking the Ok button opens the order page of the website.
In addition to transferring data for 5 database fields, the conversion features shown on the GUI 
tab of the Migration Process window will convert 5 layouts or forms/reports & scripts.
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Demo Mode - About Tab

Clicking the "License" button on the About tab, or selecting the Help -> License/About menu items 
will open the About window where you can enter the license key.
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About/License Window

On the About FmPro Migrator window:
(1) Product name and version licensed, (2) Demo or Licensed will be displayed, (3) The Upgrade 
button opens the website order page, (4) Email address associated with your license key, (5) 
Clipboard button reads the license key from the clipboard, (6) License key field, (7) Email Support 
button opens the Contact form on the website, (8) Visit Website opens the order page in Demo 
mode or the product page in Licensed mode, (9) Check for Update opens the downloads page 
with the latest software version, (10) Ok button closes the About window.
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Pasting License Key

Your product license key will be displayed in your web browser when your order has been 
completed. It will also will be sent via email at the same time, please check your SPAM folder if 
the email doesn't arrive in a few minutes.

(1) Copy the license key to the clipboard and click the clipboard icon. Once validated (2) the 
product name will change, (3) the License validation date will be updated, (4) your email address 
will be displayed, and (5) the license key will be displayed in the field under the Email address 
when clicking inside the field. In this screenshot the license key has been obscured.

Note: The license key field also allows directly pasting the license key instead of clicking the 
clipboard icon.

And that is all you need to do to license all of the features of FmPro Migrator.
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Importing FileMaker Pro Database Info

This document explains the process of importing FileMaker Pro (as well as other databases) into 
FmPro Migrator for a wide range of conversion projects shown on the GUI tab of the Migration 
Process window.

1) Prior to performing any of the migration procedures listed below, it is recommended that you 
review the database structure of the FileMaker database(s) you are migrating. It is important to 
insure that each table is configured with a Primary Key column. FmPro Migrator looks for columns 
having the Unique and Not Empty validation properties in order to automatically determine which 
column should be created as a Primary Key column in the SQL database. 

2) Download and following the instructions in the How to Import FileMaker Pro Databases into 
FmPro Migrator PDF manual from the FmPro Migrator support web page. Select Help from the 
Help menu in FmPro Migrator and your web browser will open this web page. It is generally a 
good idea to migrate the data into the SQL database, and also create relationships in the SQL 
database prior to migrating the Layouts into another development environment.

3) If you are transferring data from FileMaker Pro to a SQL database server, then download the 
appropriate manual on the support page for the destination SQL database. The Pre-Migration 
Preparation Process PDF provides another resource for migrating the data from FileMaker Pro to 
SQL database servers.

At the completion of these procedures, your data should already be migrated to the destination 
SQL database, and the Layouts, Value Lists, Scripts and Relationships should have been 
imported into FmPro Migrator.
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Step 1 - Import Database Info 
- Microsoft Access
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Importing Microsoft Access Database Info

1) Prior to performing any of the migration procedures listed below, it is recommended that you 
review the database structure of the Microsoft Access database(s) you are migrating. It is 
important to insure that each table is configured with a Primary Key column. FmPro Migrator looks 
for columns having the Unique and Not Empty validation properties in order to automatically 
determine which column should be created as a Primary Key column in the SQL database. 

2) Download and following the instructions in the How to Import Microsoft Access Databases into 
FmPro Migrator PDF manual from the FmPro Migrator support web page. Select Help from the 
Help menu in FmPro Migrator and your web browser will open this web page.

3) If you are transferring data from Microsoft Access to a SQL database server, then you will likely 
use an importing procedure to import the data from the Access .mdb/.accdb file(s) into the 
destination SQL database. [FmPro Migrator supports directly copying data to FileMaker Pro 
databases, but not into SQL database servers.]

At the completion of these procedures, your data should already be migrated into the destination 
SQL database, and the Forms/Reports, Value Lists, Scripts and Relationships should have been 
imported into FmPro Migrator.
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Step 1 - Import Database Info 
- Visual FoxPro
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Importing Visual FoxPro Applications

1) Prior to performing any of the migration procedures listed below, it is recommended that you 
review the database structure of the Visual FoxPro project you are migrating. It is important to 
insure that each table is configured with a Primary Key column. FmPro Migrator looks for columns 
having the Unique and Not Empty validation properties in order to automatically determine which 
column should be created as a Primary Key column in the SQL database. Also, columns marked 
as NOT NULL should not contain NULL values, or the data transfer process will fail.

2) Download and following the instructions in the How to Import Visual FoxPro Projects into 
FmPro Migrator PDF manual from the FmPro Migrator support web page. Select Help from the 
Help menu in FmPro Migrator and your web browser will open this web page.

3) If you are transferring data from Microsoft Access to a SQL database server, then you may use 
an importing procedure to import the data from the DBF file(s) into the destination SQL database. 
Or you may use FmPro Migrator to transfer data from the DBF files into the destination SQL 
database server.

At the completion of these procedures, your data should already be migrated into the destination 
SQL database, and the Forms/Reports, Value Lists, Scripts and Relationships should have been 
imported into FmPro Migrator.
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.Net Conversion Processing
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Using Licensed Mode -  .Net Conversion Service

Using the .Net Conversion Service in Demo mode, limits processing tasks to 5 Forms/Reports 
and 5 scripts. Ordering a license key lifts these operating limits for this service. Using the License 
Key allows for the processing of an unlimited number of database files and scripts for the 
purchased Layouts/Forms quantity during the duration of the license key.

Select Processing Type - Licensed 

(1) Enter a name for the new .Net Visual Studio project which will be created by FmPro Migrator.
(2) Select an output directory where the generated project files will be written. A new folder having 
the same name as the project will be created within the selected Project Directory folder. Two 
folders will be created within this folder, for the VB and C# project files.
(3) Enter a name for the ADO.NET data source which will be created manually within Visual 
Studio. This name will be used for naming the Entity Framework model within the project.
(4) The number of forms/layouts to be converted. (5) Script Status menu = Normal or Commented. 
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The Script Status feature enables the Commented option to be selected which will comment out 
form XAML , C# and VB code in the project. This feature can be helpful for troubleshooting in case 
you want to enable small sections of code at a time within Visual Studio.

Migration Statistics - Licensed Mode

(1) Clicking the Migrate button performs the conversion of the Forms/Reports, with the (2) 
resulting processing statistics displayed above the Migrate button.
(3) Now the Code Conversion Workbench button can be opened to perform the conversion of the 
scripts into .NET C# or VB code.
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Review of Generated Visual Studio 2022 Project Files

.Net Project Files

A screenshot of an example project generated by FmPro Migrator is show above.



FmPro Migrator - FileMaker Pro, Microsoft Access, Visual FoxPro to .Net Automated Conversion Procedure - 19

AppResources.xml Contents

Static Value Lists are converted into XML code which is saved in the AppResources.xml file. The 
Value List names displayed in the FmPro Migrator Value List tab are used as the identifier of each 
Value List. The Value List items follow the name tag, and contain a Name tag for each item 
followed by its data.
Note: Field based value lists are not converted.
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Value List Definition - Window XAML Code

Each Value List used within a window, is defined as an XmlDataProvider near the top of the 
window XAML code file.
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Window Scrollbar Implementation

Windows which contain objects beyond the displayed window size, will automatically show 
Horizontal or Vertical scrollbars on an as needed basis.
Windows which have contents exceeding a size of 800 x 600 pixels, are configured with a 
maximum display size of 800 x 600 pixels in the Title tags. These properties can be changed as 
needed. This is done so that the window doesn't open so large that the window has to be moved 
in order to resize it. 

For the Assets_v8 window shown above, the (1) Title tag has been set to a maximum size of 800 x 
600 pixels, but the size of the (2) canvas object is actually 1790 x 2301. The Canvas object is used 
in the generation of the XAML windows in order to accurately represent each object's size and 
position as it was located within the original source database Layout or Form.
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.Net Conversion Service - 
Manual Tasks
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Create ADO.NET Data Source

Prior to Building or running the newly generated Visual Studio projects, it is necessary to create a 
Data Source for the database server which will be used by the project. 

.Net Conversion Service Properties - Data Source Name

The screenshots in the ADO.NET Data Source setup use a project named Assets002, using an 
ADO.NET Data Source named AssetsDB.
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Open Visual Studio Project File

Double-click on either of the Visual Studio project or solution files, to open the project in Visual 
Studio 2022.

Once the project has been opened, there will be many errors displayed in the Errors list below the 
development window. These errors are due to the lack of a Data Source for the project, even 
though the errors may point to src:WindowBase, MenuUserControl or other objects within the 
project. 
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Add New Item Menu

Add a new Item from the Project menu.

Show All Templates Option

Click the Show All Templates button to show all of the available options.
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Click Data -> ADO.NET Entity Model Option

(1) Click the Data category, (2) Click the ADO.NET Entity Model Option, (3) Click the Add button.
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Choose Database

(1) Click EF Designer from database (2) click the Next button.
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Select Connection, Enter Entity Connection Name

(1) Select an existing data connection name or create a new one, (2) Include or Exclude sensitive 
data from the connection string, (3) and enter the connection name. In this example, the Data 
Source name entered into the .Net Conversion Service window was AssetsDB. Therefore the 
Entity Connection name should be <Data Source Name>Entities - which will become 
AssetsDBEntities. The Entity Name listed here must exactly match the generated files, or errors 
will still be displayed in Visual Studio. (4) Click the Next button.
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Creating Database Connection

Create a connection using the Connection Properties dialog. (1, 2, 3) Enter connection info, (4) 
click the Test Connection button. (5) Select a database name from the menu once the test has 
passed. (6) Click the Ok button.



FmPro Migrator - FileMaker Pro, Microsoft Access, Visual FoxPro to .Net Automated Conversion Procedure - 30

Choose or Install Correct Entity Framework Version

(1) Choose Entity Framework version or install a newer version before reaching this step. (2) Click 
the Next button.
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Select Tables, Name the Model

(1) Select the tables, views which should be included in the data model. (2) Enter the Model 
Namespace. In this example, the Data Source name entered into the .Net Conversion Service 
window was AssetsDB. Therefore the Model Namespace must be <Data Source Name>Model - 
which will become AssetsDBModel. The Model Namespace listed here must exactly match the 
generated files, or errors will still be displayed in Visual Studio. (3) Click the Finish button.
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Troubleshooting - Visual Studio 2022 on Windows 11 ARM

[2024] When performing the creation of the Entity Framework model on Windows 11 ARM and 
Visual Studio 2022 version 17.10.1, this error message is always displayed. This error doesn't 
occur on Windows x86 versions of Visual Studio 2022.

Re-Generating The Project

FmPro Migrator avoids writing over the Visual Studio project files containing the Data Source 
information. Therefore if the project needs to be re-created, the same Data Source will be reused.

From a troubleshooting standpoint, this is significant because in some cases you might want to 
start from the beginning. If this is the case, Exit Visual Studio and delete the top-level project 
directory. However, if the Visual Studio Debugger has been used on a project, it seems that it is 
usually necessary to manually delete the contents of the bin folder which contains the <Project 
Name>.vhost.exe file. 
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Manual Tasks - .Net Conversion Service

There are some processing steps which must be completed manually when performing a .Net 
Conversion.

LoginWindow.xaml

The default startup window is the LoginWindow.xaml window. This window is just a placeholder 
XAML file containing no executable code for the Login button. Application specific login code 
would need to be added in the LoginWindow.cs/vb file in order to avoid having the data source 
connection information exposed within the App.Config file.
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Set StartupUri

The App.xaml file can be changed to select another form in the project by changing the StartupUri 
property.

Layout Parts - Header, Footer, Subsummary

The implementation of Report Header, Footer, Subsummary parts requires application-specific 
development code within code behind files. 

Unsupported Form/Report Objects

Some Layout/Form objects are not supported for automated conversion as listed below:
FileMaker Pro Layouts:
Merge Fields
Layout Date, Time, Page Number objects
Chart Objects
WebViewer

Microsoft Access Forms/Reports:
acCustomControl (ActiveX)
chart
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Visual FoxPro Forms/Reports:
Timer
OLEControl
HyperLink

Missing Relationships Report.xls

It is not always possible to export all of the relationships from a particular database for use in the 
automated conversion process. Within FileMaker Pro databases, some relationships are inferred 
automatically from existing relationships. Within Microsoft Access and Visual FoxPro projects, 
relationships may be implemented via Queries or application-specific programming code. 
Therefore FmPro Migrator analyzes the project as the objects are being created within each XAML 
file. If a relationship cannot be found for a field in another table, this information will be written into 
the Missing Relationships Report.xls file. 

The columns in the report show:
Object Name -  The name of the object as it has been created in the XAML file.
Form Name - The name of the form.
Relationship (Missing) - The Left Table and Right Table names for the proposed relationship to 
be created. 

Within this file, the same missing relationship will be listed multiple times - as it will be listed for 
each object. Therefore fixing the problem for one field will likely fix the problem for many fields. 
Some relationship names will appear empty or incomplete - if there wasn't enough info available 
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to determine the table names required for the relationship.

This report is written into the FmPro Migrator output directory.

Entity Model Designer

Visual Studio creates the data model and entity framework code from the database connection. If 
changes are made to the database, the model can be updated from the updated database 
schema. Or changes can be made to the model without making changes to the database. 
Therefore either technique can be used to resolve issues with missing relationships.
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.Net Relationship Info in <Window.xaml.cs>

Each code behind file contains ObjectQuery code intended to be used for accessing fields within 
the table associated with the Layout/Form and also with related database tables. This code is 
built during the analysis and creation of objects on each window. If the relationship structure 
changes too much during the process of adding missing relationships to the data model, then 
this code may also need to be modified. But by default, the code is designed with the assumption 
that all of the fields on the window are either associated with the 1st table listed or are located in a 
related table. 

Grid Column Sizes

FmPro Migrator automatically creates a new portal to represent any SubForms/SubReports found 
on the original Access Form/Report. Unlike FileMaker portal objects, Access SubForm/SubReport 
objects contain horizontal scrollbars. Therefore there could be too many fields incorporated on the 
original SubForm/SubReport to make a readable display within the area of the new FileMaker 
portal. FmPro Migrator 

It isn't possible to determine the width of columns located on Microsoft Access SubForms or 
Visual FoxPro Grid objects. Therefore FmPro Migrator divides the width of the portal by the number 
of fields and creates each field of the same size. The fields are also created in the same left to 
right display order as they were created on the original SubForm/Grid. It may be necessary to 
manually resize the individual WPF Grid fields to accommodate the actual data which will be 
displayed within the Grid.
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Code Conversion

All of the code from the original database is copied over to the new .Net project as commented 
code within the App.xaml.cs/Application.xaml.vb files. This code is intended to serve as a guide 
when writing new .Net application code having the same functionality.

Overlapping Layout Objects

There isn't any method to determine the top to bottom stacking order of objects on an Access 
Form/Report. FmPro Migrator builds objects within the new XAML file in a specific logical order to 
minimize issues with overlapping objects. The order of creating layout objects is:
Rectangle
Line
Graphic Image
Text Label
Field

Some cosmetic changes will potentially still need to be performed manually to fine tune the 
stacking order.

Duplicate Objects Report.xls

Value Lists having exactly the same name and contents and Layouts having exactly the same 
contents will be skipped during the conversion process, and will be reported in the Duplicate 
Objects Report.xls file. During the capture of layouts from FileMaker Pro, it is possible that a file 
could accidentally be captured twice. Before making manual modifications, to the XAML, vb/cs 
files - this report should be checked. If there were no objects skipped during processing, a report 
will not be created. 
This report is written into the FmPro Migrator output directory.
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Missing Layout Table Report.txt

FmPro Migrator attempts to associate each Layout/Form with a database table. This information 
is used to create the CollectionViewSource in the XAML and code behind files. If a table is not 
associated with a Layout/Form, its name will be listed in the Missing Table Report.txt. This report 
is written into the FmPro Migrator output directory. Fixing this issue will require manual 
intervention. 
1) Manually associate a table with each Layout in on the Layouts tab of the FmPro Migrator 
Migration Process window.
2) Or change the XAML and code behind files appropriately so that the CollectionViewSource and 
query info is not being used. This situation might occur if you are manually writing your own code 
to populate the objects in the window.
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